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How Do I?
Learn how to use your HP All-in-One
•
•
•
•
•

“Wireless Connection using a WPS enabled router” on page 5
“Copy text or mixed documents” on page 33
“Scan to a computer” on page 31
“Load media” on page 27
“Replace the cartridges” on page 39
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Finish setting up the HP All-inOne
•
•
•
•

Wireless Connection using a WPS enabled router
Traditional Wireless Connection
USB Connection
Install the software for a network connection

Wireless Connection using a WPS enabled router
To connect the HP All-in-One to a wireless network using WiFi Protected Setup (WPS),
you will need the following:
A wireless 802.11 network that includes a WPS-enabled wireless router or access
point.
A desktop computer or laptop with either wireless networking support, or a network
interface card (NIC). The computer must be connected to the wireless network that
you intend to install the HP All-in-One on.

Use Push Button (PBC) method if your router has a WPS button
a. Set up wireless connection.
Press and hold the Wireless button for two seconds.
Press the corresponding button on the WPS-enabled router or other
networking device.
The Wireless icon and signal strength bar appear solid on successful
configuration of the wireless network.
b. Install Software.
NOTE: The product begins a timer for approximately two minutes in which the
corresponding button on the networking device needs to be pressed.
Use PIN method if your WPS enabled router does not have a WPS button
a. Load paper.
Insert stack of paper into paper tray with short edge forward and print side
down.
Slide stack of paper forward until it stops.
Slide paper-width guide to the right until it stops at edge of paper.

Finish setting up the HP All-in-One
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Wireless Connection using a WPS enabled router
▲ Do one of the following:
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b. Print WPS PIN.
Press and hold the Scan button for two seconds.
Wireless test starts.
Wireless test report and Network Configuration report are printed
automatically.
c. Set up wireless connection.
Press and hold the Wireless button for two seconds.
Enter the PIN on a computer for the router.
The Wireless icon and signal strength bar appear solid on successful
configuration of the wireless network.
d. Install software
NOTE: The product begins a timer for approximately two minutes in which the
corresponding button on the networking device needs to be pressed.
Finish setting up the HP All-in-One

Related topics
“Install the software for a network connection” on page 8

Test wireless setup and print network configuration page
The wireless network test performs a series of diagnostic tests to determine whether
network setup is successful. You can print the wireless network test at any time.
You can print a network configuration page to see network settings such as the IP
address, communication mode, and network name (SSID).
To print the network configuration page
▲ Press and hold the Scan button to initiate the wireless test and print the Network
Configuration and Network Test pages.
You can also change the printer's default language, using the HP Solution Center, to print
the Network Configuration Page and Network Test Report in your desired language.
Change the default language using HP Solution Center
1. Connect the product to the computer.
2. Open HP Solution Center to access the embedded web server.
a. Click Start, and then Programs.
b. Click HP Deskjet F4500 All-in-One series, and then click Solution Center.
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c. In the HP Solution Center, click Settings.
d. On the Settings page, click Network Configuration. The embedded web server
window opens.
e. Click Settings.
f. In the Preferences area, click International.
g. Select the desired language, and then click Apply.

Traditional Wireless Connection
To connect the HP All-in-One to an integrated wireless WLAN 802.11 network, you will
need the following:

To connect the product
1. Insert the product Software CD in the computer CD-ROM drive.
2. Follow the instructions on the screen.
When you are prompted, connect the product to the computer using the USB setup
cable included in the box. The product will attempt to connect to the network. If the
connection fails, follow the prompts to correct the problem, and then try again.
3. When the setup is finished, you will be prompted to disconnect the USB cable and
test the wireless network connection. Once the product connects successfully to the
network, install the software on each computer that will use the product over the
network.
Related topics
“Install the software for a network connection” on page 8

USB Connection
The HP All-in-One supports a rear USB 2.0 High Speed port for connection to a computer.
To connect the product with the USB cable
▲ Refer to the setup instructions that came with your product for information on
connecting to a computer with a USB cable.
NOTE: Do not connect the USB cable to the product until you are prompted to
do so.

USB Connection
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A wireless 802.11 network that includes a wireless router or access point.
If you connect the HP All-in-One on a wireless network that has Internet access, HP
recommends that you use a wireless router (access point or base station) that uses
Dynamic Host Configuration Protocol (DHCP).
A desktop computer or laptop with either wireless networking support, or a network
interface card (NIC). The computer must be connected to the wireless network that
you intend to install the HP All-in-One on.
Network name (SSID).
WEP key or WPA Passphrase (if needed).
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To enable printer sharing on a Windows computer
▲ Refer to the user guide that came with your computer or see the Windows onscreen
Help.

Install the software for a network connection
Use this section to install the HP Photosmart software on a computer connected to a
network. Before you install the software, make sure you have connected the HP All-inOne to a network. If the HP All-in-One has not been connected to a network, follow the
onscreen instructions during the software installation to connect the product to the
network.
NOTE: If your computer is configured to connect to a series of network drives, make
sure that your computer is currently connected to these drives before installing the
software. Otherwise, the HP Photosmart software installer might try to use one of the
reserved drive letters and you will not be able to access that network drive on your
computer.
NOTE: Installation time can range from 20 to 45 minutes depending on your
operating system, the amount of available space, and the processor speed of your
computer.
To install the Windows HP Photosmart Software on a networked computer
1. Quit all applications running on your computer.
2. Insert the Windows CD that came with the product into the CD-ROM drive on your
computer and follow the onscreen instructions.
Finish setting up the HP All-in-One

NOTE: If the HP All-in-One is not connected to a network, connect the product
to the computer using the USB setup cable included in the box. Do not connect
the USB setup cable to the computer until prompted. The product will then attempt
to connect to the network.
3. If a dialog box about firewalls appears, follow the instructions. If you see firewall popup messages, you must always accept or allow the pop-up messages.
4. On the Connection Type screen, select an appropriate option, and then click Next.
The Searching screen appears as the Setup program searches for the product on
the network.
5. On the Printer Found screen, verify that the printer description is correct.
If more than one printer is found on the network, the Printers Found screen appears.
Select the product you want to connect.
6. Follow the prompts to install the software.
When you have finished installing the software, the product is ready for use.
7. To test your network connection, go to your computer and print a self-test report to
the product.
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Get to know the HP All-in-One
•
•

Printer parts
Control panel features

Printer parts

1

Control panel

2

Cartridge door

3

Paper-width guide for paper tray

4

Paper tray

5

Paper tray extender (also referred to as the tray extender)

6

Paper stop

7

Carriage

8

Glass

9

Lid backing

10

Rear access door

11

Rear USB port

12

Power connection (Use only with the power adapter supplied by HP.)

13

Lid

14

Load original label

15

Print cartridges
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Control panel features
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Get to know the HP All-in-One
10

1

On: Turns the product on or off. When the product is off, a minimal amount of power is still
used. To completely remove power, turn off the product, then unplug the power cord.

2

Cancel: Stops the current operation.

3

Scan: Starts a scan of an original placed on the glass. Press and hold for two seconds to
begin wireless test.

4

Paper Selection: Changes the paper type setting for copying to either plain or photo paper.
The Paper Selection lights indicate the currently selected paper size and type as Plain Letter
or A4, Large Photo or Small Photo.

5

Actual Size/Resize to Fit: Scales the original to the maximum size to fit within the margins
of the selected paper size for copying.

6

Start Copy Black: Starts a black-and-white copy job.

7

Start Copy Color: Starts a color copy job.

8

Number of Copies LCD: Displays the number of copies to be made. Also displays a warning
when the device is out of paper.

9

Ink Level Indicator Light: Show ink level information for each print cartridge, four indicators
for the tri-color cartridge and four indicators for the black cartridge. Also displays a warning
for print cartridge problems.

10

Attention light: Flashing if there is an error or if some user action is required.

11

Wireless indicator light: Indicates that the wireless radio is on.

12

Wireless button: Turns the wireless radio on or off.

Get to know the HP All-in-One
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Print
Choose a print job to continue.

Print

“Print documents” on page 11

“Print photos” on page 12

“Print envelopes” on page 14

“Print on specialty media” on page 15

“Print a Web page” on page 21

Related topics
• “Load media” on page 27
• “Recommended papers for printing” on page 25

Print documents
Most print settings are automatically handled by the software application. You need to
change the settings manually only when you change print quality, print on specific types
of paper or transparency film, or use special features.
To print from a software application
1. Make sure you have paper loaded in the paper tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. If you need to change settings, click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
NOTE: When printing a photo, you must select options for the specific photo
paper and photo enhancement.

Print
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5. Select the appropriate options for your print job by using the features available in the
Advanced, Printing Shortcuts, Features, and Color tabs.
TIP: You can easily select the appropriate options for your print job by choosing
one of the predefined print tasks on the Printing Shortcuts tab. Click a type of
print task in the Printing Shortcuts list. The default settings for that type of print
task are set and summarized on the Printing Shortcuts tab. If necessary, you
can adjust the settings here and save your custom settings as a new printing
shortcut. To save a custom printing shortcut, select the shortcut and click Save
As. To delete a shortcut, select the shortcut and click Delete.
Print

6. Click OK to close the Properties dialog box.
7. Click Print or OK to begin printing.
Related topics
• “Recommended papers for printing” on page 25
• “Load media” on page 27
• “View the print resolution” on page 23
• “Use printing shortcuts” on page 23
• “Set the default print settings” on page 24
• “Stop the current job” on page 59

Print photos
To print a photo on photo paper
1. Remove all paper from the input tray, and then load the photo paper print side down.

2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Features tab.
6. In the Basic Options area, select the appropriate photo paper type from the Paper
Type drop-down list.
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7. In the Resizing Options area, click the appropriate paper size from the Size list.
If the paper size and paper type are not compatible, the product software displays an
alert and allows you to select a different type or size.
8. In the Basic Options area, select a high print quality, such as Best, from the Print
Quality drop-down list.

9. Click OK to return to the Properties dialog box.
10. (Optional) If you want to print the photo in black and white, click the Color tab and
select the Print in grayscale check box. From the drop-down list, select one of the
following options:
• High Quality: uses all the available colors to print your photo in grayscale. This
creates smooth and natural shades of gray.
• Black Ink Only: uses black ink to print your photo in grayscale. The gray shading
is created by varying patterns of black dots, which might result in a grainy image.
11. Click OK, and then click Print or OK in the Print dialog box.
NOTE: Do not leave unused photo paper in the input tray. The paper might start to
curl, which could reduce the quality of your printout. Photo paper should be flat before
printing.
To print a borderless image
1. Remove all paper from the input tray.
2. Place the photo paper print side down on the right side of the input tray.
3. On the File menu in your software application, click Print.
4. Make sure the product is the selected printer.
5. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
6. Click the Features tab.
7. In the Size list, click the size of photo paper loaded in the input tray.
If a borderless image can be printed on the specified size, the Borderless printing
check box is enabled.
8. In the Paper Type drop-down list, click More, and then select the appropriate paper
type.
NOTE: You cannot print a borderless image if the paper type is set to Plain
paper or to a type of paper other than a photo paper.

Print photos
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NOTE: For maximum dpi resolution, go to the Advanced tab, and then select
Enabled from the Maximum dpi drop-down list. For more information, see “Print
using the maximum dpi” on page 22.

Chapter 4

9. Select the Borderless printing check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the product software
displays an alert and allows you to select a different type or size.
10. Click OK, and then click Print or OK in the Print dialog box.
NOTE: Do not leave unused photo paper in the input tray. The paper might start
to curl, which could reduce the quality of your printout. Photo paper should be flat
before printing.

Print

Related topics
• “Load media” on page 27
• “Print using the maximum dpi” on page 22
• “View the print resolution” on page 23
• “Use printing shortcuts” on page 23
• “Set the default print settings” on page 24
• “Stop the current job” on page 59

Print envelopes
You can load one or more envelopes into the paper tray of the HP All-in-One. Do not use
shiny or embossed envelopes or envelopes that have clasps or windows.
NOTE: For specific details on how to format text for printing on envelopes, consult
the help files in your word processing software. For best results, consider using a label
for the return address on envelopes.
To print envelopes
1. Slide the paper guide all the way to the left.
2. Place the envelopes in the right side of the tray. The side to be printed on should face
down. The flap should be on the left side.
3. Push the envelopes into the printer until they stop.
4. Slide the paper guide firmly against the edge of the envelopes.

5. Open the Printer Properties dialog box.
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6. Click the Features tab, and then select the following print settings:
• Paper Type: Plain paper
• Size: An appropriate envelope size
7. Select any other print settings that you want, and then click OK.

Print

Related topics
• “Load media” on page 27
• “View the print resolution” on page 23
• “Use printing shortcuts” on page 23
• “Set the default print settings” on page 24
• “Stop the current job” on page 59

Print on specialty media
Print transparencies
1. Slide the paper guide all the way to the left.
2. Place the transparencies in the right side of the tray. The side to be printed should
face down and the adhesive strip should face up and toward the printer.
3. Carefully push the transparencies into the printer until they stop, so that the adhesive
strips do not catch on one another.
4. Slide the paper guide firmly against the edge of the transparencies.

5. Open the Printer Properties dialog box.
6. Click the Printing Shortcuts tab.
7. In the Printing Shortcuts list, click Presentation Printing, and then specify the
following print settings:
• Paper Type: Click More, and then select an appropriate transparency film.
• Paper Size: An appropriate paper size
8. Select any other print settings that you want, and then click OK.
Print postcards
1. Slide the paper guide all the way to the left.
2. Place the cards in the right side of the tray. The side to be printed on should face
down and the short edge should point toward the printer.
Print on specialty media
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3. Push the cards into the printer until they stop.
4. Slide the paper guide firmly against the edge of the cards.

Print

5. Open the Printer Properties dialog box.
6. Click the Features tab, and then specify the following print settings:
• Paper Type: Click More, click Specialty Papers, and then select an appropriate
card type.
• Print Quality: Normal or Best
• Size: An appropriate card size
7. Select any other print settings that you want, and then click OK.
Print labels
1. Slide the paper guide all the way to the left.
2. Fan the edges of the label sheets to separate them, and then align the edges.
3. Place the label sheets in the right side of the tray. The label side should face down.
4. Push the sheets into the printer until they stop.
5. Slide the paper guide firmly against the edge of the sheets.

6. Open the Printer Properties dialog box.
7. Click the Printing Shortcuts tab.
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8. In the Printing Shortcuts list, click General Everyday Printing, and then specify
the following print settings:
• Paper Type: Plain Paper
• Paper Size: An appropriate paper size
9. Click OK.

Print

Print brochures
1. Slide the paper guide all the way to the left.
2. Place the paper in the right side of the tray. The side to be printed on should face
down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.

5. Open the Printer Properties dialog box.
6. Click the Features tab.
7. Specify the following print settings:
• Print Quality: Best
• Paper Type: Click More, and then select an appropriate HP inkjet paper.
• Orientation: Portrait or Landscape
• Size: An appropriate paper size
• Two-sided printing: Manual
8. Click OK to print.
Print greeting cards
1. Slide the paper guide all the way to the left.
2. Fan the edges of the greeting cards to separate them, and then align the edges.
3. Place the greeting cards in the right side of the tray. The side to be printed on should
face down.
4. Push the cards into the printer until they stop.
5. Slide the paper guide firmly against the edge of the cards.

Print on specialty media
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6. Open the Printer Properties dialog box.
7. Click the Features tab, and then specify the following print settings:
• Print Quality: Normal
• Paper Type: Click More, and then select an appropriate card type.
• Size: An appropriate card size
8. Select any other print settings that you want, and then click OK.
Print booklets
1. Slide the paper guide all the way to the left.
2. Place plain paper in the right side of the tray. The side to be printed on should face
down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.

5.
6.
7.
8.

Open the Printer Properties dialog box.
Click the Printing Shortcuts tab.
In the Printing Shortcuts list, click Booklet Printing.
In the Print On Both Sides drop-down list, select one of the following binding options:
• Left Edge Booklet
• Right Edge Booklet
9. Select any other print settings that you want, and then click OK.
10. When prompted, reload the printed pages in the paper tray as shown below.
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11. Click Continue to finish printing the booklet.
Print posters
1. Slide the paper guide all the way to the left.
2. Place plain paper in the right side of the tray. The side to be printed on should face
down.
3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.

5. Open the Printer Properties dialog box.
6. Click the Features tab, and then specify the following print settings:
• Paper Type: Plain Paper
• Orientation: Portrait or Landscape
• Size: An appropriate paper size
7. Click the Advanced tab, and then click Printer Features.
8. In the Poster Printing drop-down list, select the number of sheets for the poster.
9. Click the Select Tiles button.
10. Check that the number of tiles that are selected matches the number of sheets for
the poster, and then click OK.

Print on specialty media
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11. Select any other print settings that you want, and then click OK.
Print iron-on transfers
1. Slide the paper guide all the way to the left.
2. Place the iron-on transfer paper in the right side of the tray. The side to be printed on
should face down.

3. Push the paper into the printer until it stops.
4. Slide the paper guide firmly against the edge of the paper.

5. Open the Printer Properties dialog box.
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6. Click the Features tab, and then specify the following print settings:
• Print Quality: Normal or Best
• Paper Type: Click More, click Specialty Papers, and then click Other specialty
paper.
• Size: An appropriate paper size
7. Click the Advanced tab.
8. Click Printer Features, and then set Mirror Image to On.

Print

NOTE: Some iron-on transfer software programs do not require you to print a
mirror image.
9. Select any other print settings that you want, and then click OK.
Related topics
• “Recommended papers for printing” on page 25
• “Load media” on page 27
• “Use printing shortcuts” on page 23
• “Set the default print settings” on page 24
• “Stop the current job” on page 59

Print a Web page
You can print a Web page from your Web browser on the HP All-in-One.
If you use Internet Explorer (6.0 or higher) or Firefox (2.0 or higher) for Web browsing,
you can use HP Smart Web Printing to ensure simple, predictable web printing with
control over what you want and how you want it printed. You can access HP Smart Web
Printing from the toolbar in Internet Explorer. For more information about HP Smart Web
Printing, see the help file provided with it.
To print a Web page
1. Make sure you have paper loaded in the paper tray.
2. On the File menu in your Web browser, click Print.
TIP: For best results, select HP Smart Web Printing on the File menu. A check
mark appears when it is selected.
The Print dialog box appears.
3. Make sure the product is the selected printer.
4. If your Web browser supports it, select the items on the Web page that you want to
include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as As
laid out on screen, Only the selected frame, and Print all linked documents.
5. Click Print or OK to print the Web page.
TIP: To print Web pages correctly, you might need to set your print orientation to
Landscape.

Print a Web page
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Related topics
• “Recommended papers for printing” on page 25
• “Load media” on page 27
• “View the print resolution” on page 23
• “Use printing shortcuts” on page 23
• “Set the default print settings” on page 24
• “Stop the current job” on page 59

Print using the maximum dpi
Print

Use maximum dpi mode to print high-quality, sharp images.
To get the most benefit from maximum dpi mode, use it to print high-quality images such
as digital photographs. When you select the maximum dpi setting, the printer software
displays the optimized dots per inch (dpi) that the HP All-in-One printer will print. Printing
in maximum dpi is supported on the following paper-types only:
•
•
•
•

HP Premium Plus Photo Paper
HP Premium Photo Paper
HP Advanced Photo Paper
Photo Hagaki

Printing in maximum dpi takes longer than printing with other settings and requires a large
amount of disk space.
To print in Maximum dpi mode
1. Make sure you have paper loaded in the paper tray.
2. On the File menu in your software application, click Print.
3. Make sure the product is the selected printer.
4. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
5. Click the Advanced tab.
6. In the Printer Features area, select Enabled from the Maximum dpi drop-down list.
7. Click the Features tab.
8. In the Paper Type drop-down list, click More, and then select the appropriate paper
type.
9. In the Print Quality drop-down list, click Maximum dpi.
NOTE: To view the maximum dpi that the product will print, click Resolution.
10. Select any other print settings that you want, and then click OK.
Related topics
“View the print resolution” on page 23
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View the print resolution

To view the print resolution
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.
3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Features tab.
5. In the Paper Type drop-down list, select the type of paper that you have loaded.
6. In the Print Quality drop-down list, select the appropriate print quality setting for your
project.
7. Click the Resolution button to view the print resolution dpi for the paper type and
print quality combination you selected.

Use printing shortcuts
Use printing shortcuts to print with print settings that you use often. The printer software
has several specially designed printing shortcuts that are available in the Printing
Shortcuts list.
NOTE: When you select a printing shortcut the appropriate printing options are
automatically displayed. You can leave them as is, change them, or create your own
shortcuts for commonly used tasks.
Use the Printing Shortcuts tab for the following print tasks:
•
•
•
•
•
•

General Everyday Printing: Print documents quickly.
Photo Printing–Borderless: Print to the top, bottom, and side edges of 10 x 15 cm
(4 x 6 inch) and 13 x 18 cm (5 x 7 inch) HP Photo Papers.
Paper-saving Printing: Print two-sided documents with mutliple pages on same
sheet to reduce paper usage.
Photo Printing–With White Borders: Print a photo with a white border around the
edges.
Fast/Economical Printing: Produce draft-quality printouts quickly.
Presentation Printing: Print high-quality documents, including letters and
transparencies.

To create a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.

Use printing shortcuts
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The printer software displays the print resolution in dots per inch (dpi). The dpi varies
according to the paper type and print quality that you select in the printer software.

Chapter 4

3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click a printing shortcut.
The print settings for the selected printing shortcut are displayed.
6. Change the print settings to those you want in the new printing shortcut.
7. Click Save as and type a name for the new printing shortcut, and then click Save.
The printing shortcut is added to the list.
Print

To delete a printing shortcut
1. On the File menu in your software application, click Print.
2. Make sure the product is the selected printer.
3. Click the button that opens the Properties dialog box.
Depending on your software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.
4. Click the Printing Shortcuts tab.
5. In the Printing Shortcuts list, click the printing shortcut that you want to delete.
6. Click Delete.
The printing shortcut is removed from the list.
NOTE: Only the shortcuts that you have created can be deleted. The original HP
shortcuts cannot be deleted.

Set the default print settings
If there are settings that you frequently use for printing, you might want to make them the
default print settings so they are already set when you open the Print dialog box from
within your software application.
To change the default print settings
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Settings.
2. Make changes to the print settings, and click OK.
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Paper basics
You can load many different types and sizes of paper in the HP All-in-One, including letter
or A4 paper, photo paper, transparencies, and envelopes.
This section contains the following topics:
•
•

“Recommended papers for printing” on page 25
“Load media” on page 27

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without smudging.
It resists water, smears, fingerprints, and humidity. Your prints have a look and feel
comparable to a store-processed photo. It is available in several sizes, including A4, 8.5
x 11 inch, 10 x 15 cm (4 x 6 inch) (with or without tabs), 13 x 18 cm (5 x 7 inch), and two
finishes - glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.
HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo
printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp
images when you use this paper with any inkjet printer. It is available in semi-gloss finish
in several sizes, including A4, 8.5 x 11 inch, and 10 x 15 cm (4 x 6 inch) (with or without
tabs). For longer-lasting photos, it is acid-free.
HP Brochure Paper or HP Superior Inkjet Paper
These papers are glossy-coated or matte-coated on both sides for two-sided use. They
are the perfect choice for near-photographic reproductions and business graphics for
report covers, special presentations, brochures, mailers, and calendars.
HP Premium Presentation Paper or HP Professional Paper
These papers are heavy two-sided matte papers perfect for presentation, proposals,
reports, and newsletters. They are heavyweight for an impressive look and feel.
HP Bright White Inkjet Paper
HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque
enough for two-sided color usage with no show-through, which makes it ideal for
newsletters, reports, and flyers. It features ColorLok Technology for less smearing, bolder
blacks, and vivid colors.
HP Printing Paper
HP Printing Paper is a high-quality multifunction paper. It produces documents that look
and feel more substantial than documents printed on standard multipurpose or copy
Paper basics
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Depending on your country/region, some of these papers might not be available.
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paper. It features ColorLok Technology for less smearing, bolder blacks, and vivid colors.
It is acid-free for longer lasting documents.
HP Office Paper
HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts,
memos, and other everyday documents. It features ColorLok Technology for less
smearing, bolder blacks, and vivid colors. It is acid-free for longer lasting documents.
HP Iron-On Transfers
HP Iron-on Transfers (for color fabrics or for light or white fabrics) are the ideal solution
for creating custom T-shirts from your digital photos.
HP Premium Inkjet Transparency Film
HP Premium Inkjet Transparency Film make your color presentations vivid and even more
impressive. This film is easy to use and handle and dries quickly without smudging.
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HP Photo Value Pack
HP Photo Value Packs conveniently package original HP cartridges and HP Advanced
Photo Paper to save you time and take the guesswork out of printing affordable
professional photos with your HP All-in-One. Original HP inks and HP Advanced Photo
Paper have been designed to work together so your photos are long lasting and vivid,
print after print. Great for printing out an entire vacation’s worth of photos or multiple prints
to share.
ColorLok
HP recommends plain papers with the ColorLok logo for printing and copying of everyday
documents. All papers with the ColorLok logo are independently tested to meet high
standards of reliability and print quality, and produce documents with crisp, vivid color,
bolder blacks, and dry faster than ordinary plain papers. Look for papers with the ColorLok
logo in a variety of weights and sizes from major paper manufacturers.

NOTE: At this time, some portions of the HP Web site are available in English only.
To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
choose your country/region, follow the prompts to select your product, and then click one
of the shopping links on the page.
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Load media
1. Select a paper size to continue.

b. Load paper.
Insert stack of photo or other paper into paper tray with short edge forward
and print side down.
Slide stack of paper forward until it stops.
NOTE: If the photo paper you are using has perforated tabs, load photo
paper so that tabs are closest to you.
Slide paper-width guide to the right until it stops at edge of paper.

Load full-size paper
a. Prepare tray
Slide paper-width guide to the left.

Load media
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Load small-size paper
a. Prepare tray
Slide paper-width guide to the left.
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b. Load paper.
Insert stack of paper into paper tray with short edge forward and print side
down.

Paper basics

Slide stack of paper forward until it stops.
Slide paper-width guide to the right until it stops at edge of paper.

Load envelopes
a. Prepare tray
Slide paper-width guide to the left.
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Remove all paper from the paper tray.
b. Load envelopes.
Insert one or more envelopes into far-right side of the paper tray, with
envelope flaps on left and facing up.
Slide stack of envelopes forward until it stops.
Slide paper-width guide to the right against stack of envelopes until it stops.

2. View the animation for this topic.

Load media
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Scan
•

Scan to a computer

Scan to a computer
1. Do the following:
Single page scan
a. Load original.
Lift lid on product.

Scan

Load original print side down on right front corner of glass.

Close lid.

Scan
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b. Start scan.
Press Scan.
c. Preview and accept.
Preview the scanned image and accept.
2. View the animation for this topic.
Related topics
“Stop the current job” on page 59

Scan
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Copy
“Copy text or mixed documents” on page 33

Copy text or mixed documents
1. Click a copy type to continue.
Black and White Copy
a. Load paper.
Load full-size paper in the paper tray.

b. Load original.
Lift lid on product.

Copy

Load original print side down on right front corner of glass.

Copy
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Close lid.
c. Select paper type.
Press Paper Selection to select the paper type.
d. Start copy.
Press Start Copy Black. Press multiple times to increase the number of
copies.
Color Copy
a. Load paper.
Load full-size paper in the paper tray.

b. Load original.
Lift lid on product.

Copy
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Load original print side down on right front corner of glass.

Close lid.
c. Select paper type.
Press Paper Selection to select the paper type.
d. Start copy.
Press Start Copy Color. Press multiple times to increase the number of
copies.
2. View the animation for this topic.
Related topics
• “Set the copy paper type” on page 35
• “Stop the current job” on page 59

Set the copy paper type

Set the copy paper type

Copy

You can set the paper type for copying to Plain, Photo (Large), or Photo (Small).
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NOTE: Copies made on plain paper are automatically made using Normal quality.
Copies made on photo paper are automatically made using Best quality.
Refer to the following table to determine which paper type setting to choose based on the
paper loaded in the paper tray.
Paper type

Control panel setting

Copier paper or letterhead

Plain

HP Bright White Paper

Plain

HP Advanced Photo Paper, Glossy

Photo

HP Advanced Photo Paper, Matte

Photo

HP Advanced 4 x 6 inch Photo Paper

Photo (Small)

HP Photo Paper

Photo

HP Everyday Photo Paper

Photo

HP Everyday Photo Paper, Semi Gloss

Photo

Other photo paper

Photo

HP Advanced Paper

Plain

HP All-in-One Paper

Plain

HP Printing Paper

Plain

Other inkjet paper

Plain

Legal

Plain

Related topics
“Paper basics” on page 25

Copy
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Work with cartridges
•
•
•
•
•

Check the estimated ink levels
Order ink supplies
Automatically clean print cartridges
Replace the cartridges
Cartridge warranty information

Work with cartridges
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Check the estimated ink levels
You can easily check the ink supply level to determine how soon you might need to
replace a cartridge. The ink supply level shows an estimate of the amount of ink remaining
in the cartridges.
NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that
has been used in another printer, the ink level indicator might be inaccurate or
unavailable.
NOTE: Ink level warnings and indicators provide estimates for planning purposes
only. When you receive a low-ink warning message, consider having a replacement
cartridge available to avoid possible printing delays. You do not have to replace the
cartridges until the print quality is unacceptable.
NOTE: Ink from the cartridges is used in the printing process in a number of different
ways, including in the initialization process, which prepares the product and cartridges
for printing, and in printhead servicing, which keeps print nozzles clear and ink flowing
smoothly. In addition, some residual ink is left in the cartridge after it is used. For more
information, see www.hp.com/go/inkusage.
To check the ink levels from the HP Photosmart Software
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.
The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
The estimated ink levels for the ink cartridges appear.
Related topics
“Order ink supplies” on page 37

Order ink supplies
For a list of cartridge numbers, use the software that came with the HP All-in-One to find
out the reorder number.
Work with cartridges
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Find the cartridge number
1. In the HP Solution Center, click Settings, point to Print Settings, and then click
Printer Toolbox.

Work with cartridges

NOTE: You can also open the Printer Toolbox from the Print Properties dialog
box. In the Print Properties dialog box, click the Features tab, and then click the
Printer Services button.
The Printer Toolbox appears.
2. Click the Estimated Ink Level tab.
The estimated ink levels for the print cartridges appear. Use the menu at the bottom
to select Cartridge details.
To order genuine HP supplies for the HP All-in-One, go to www.hp.com/buy/supplies. If
prompted, choose your country/region, follow the prompts to select your product, and
then click one of the shopping links on the page.
NOTE: Ordering cartridges online is not supported in all countries/regions. If it is not
available in your country/region, you may still view supplies information and print a
list for reference when shopping at a local HP reseller.
To order ink cartridges from your desktop
▲ To learn which HP supplies work with your printer, order supplies online, or create a
printable shopping list, open HP Solution Center and select the online shopping
feature.
Cartridge information and links to online shopping also appear on ink alert messages.
In addition, you can find cartridge information and order online by visiting
www.hp.com/buy/supplies.
NOTE: Ordering cartridges online is not supported in all countries/regions. If it
is not available in your country/region, you may still view supplies information and
print a list for reference when shopping at a local HP reseller.
Related topics
“Choose the right cartridges” on page 38

Choose the right cartridges
HP recommends that you use original HP cartridges. Original HP cartridges are designed
and tested with HP printers to help you easily produce great results, time after time.
Related topics
“Order ink supplies” on page 37

Automatically clean print cartridges
If your printed pages are faded or if they contain ink streaks, the print cartridges might be
low on ink or might need to be cleaned. For more information, see “Check the estimated
ink levels” on page 37.
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If the print cartridges are not low on ink, clean the print cartridges automatically.

To clean the print cartridges
1. In the HP Solution Center, click Settings. In the Print Settings area, click Printer
Toolbox.
2. Click Clean the Print Cartridges.
3. Click Clean, and then follow the onscreen instructions.

Replace the cartridges
To replace the cartridges
1. Check power
2. Load paper
▲ Load full-size paper in the paper tray.
3. Remove cartridge.
a. Open cartridge door.

Wait for print carriage to move to center of the product.
b. Press down to release cartridge, then remove it from slot.

Replace the cartridges
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CAUTION: Clean print cartridges only when necessary. Unnecessary cleaning
wastes ink and shortens the life of the cartridge.

Chapter 8

4. Insert new cartridge.
a. Remove cartridge from packaging.

Work with cartridges

b. Remove plastic tape using pink pull tab.

c. Line up colored shaped icons, then slide cartridge into slot until it clicks into place.

d. Close cartridge door.
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5. Align cartridges.
6. View the animation for this topic.
Related topics
• “Choose the right cartridges” on page 38
• “Order ink supplies” on page 37

Cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP
printing device. This warranty does not cover HP ink products that have been refilled,
remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted
and the end of warranty date has not been reached. The end of warranty date, in YYYY/
MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see the printed documentation that
came with the product.

Cartridge warranty information
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Solve a problem
This section contains the following topics:
•
•
•
•
•
•

HP support
Setup troubleshooting
Print troubleshooting
Scan troubleshooting
Copy troubleshooting
Errors

HP support
Support process
HP support by phone
Additional warranty options

Support process
If you have a problem, follow these steps:
1. Check the documentation that came with the product.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is
available to all HP customers. It is the fastest source for up-to-date product
information and expert assistance and includes the following features:
• Fast access to qualified online support specialists
• Software and driver updates for the product
• Valuable product and troubleshooting information for common problems
• Proactive product updates, support alerts, and HP newsgrams that are available
when you register the product
3. Call HP support. Support options and availability vary by product, country/region, and
language.

HP support by phone
Phone support options and availability vary by product, country/region, and language.
This section contains the following topics:
•
•
•
•

Phone support period
Placing a call
Support phone numbers
After the phone support period

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America
(including Mexico). To determine the duration of phone support in Europe, the Middle
East, and Africa, go to www.hp.com/support. Standard phone company charges apply.
Solve a problem
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Placing a call
Call HP support while you are in front of the computer and the product. Be prepared to
provide the following information:
•
•
•
•

Product name (HP Deskjet F4500 All-in-One series)
Serial number (located on the back or bottom of the product)
Messages that appear when the situation occurs
Answers to these questions:
◦ Has this situation happened before?
◦ Can you re-create it?
◦ Did you add any new hardware or software to your computer at about the time
that this situation began?
◦ Did anything else occur prior to this situation (such as a thunderstorm, product
was moved, etc.)?

Support phone numbers
For the most current HP list of telephone support numbers and call costs information, see
www.hp.com/support.
Solve a problem

After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may
also be available at the HP online support Web site: www.hp.com/support. Contact your
HP dealer or call the support phone number for your country/region to learn more about
support options.

Additional warranty options
Extended service plans are available for the HP All-in-One at additional costs. Go to
www.hp.com/support, select your country/region and language, then explore the services
and warranty area for information about the extended service plans.

Setup troubleshooting
This section contains setup troubleshooting information for the product.
Many issues are caused when the product is connected to the computer using a USB
cable before the HP Photosmart software is installed on the computer. If you connected
the product to your computer before the software installation screen prompts you to do
so, you must follow these steps:
Troubleshooting common setup issues
1. Disconnect the USB cable from the computer.
2. Uninstall the software (if you have already installed it).
For more information, see “Uninstall and reinstall the software” on page 47.
3. Restart your computer.
4. Turn off the product, wait one minute, then restart it.
5. Reinstall the HP Photosmart software.

44

Solve a problem

CAUTION: Do not connect the USB cable to the computer until prompted by the
software installation screen.
This section contains the following topics:
•
•
•
•

The product will not turn on
After setting up the product, it does not print
The registration screen does not appear
Uninstall and reinstall the software

The product will not turn on
Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
•
•

Solution 1: Make sure the power cord is connected
Solution 2: Press the On button more slowly

Solution:
• Make sure the power cord is firmly connected to both the product and the power
adapter. Plug the power cord into a power outlet, surge protector, or power strip.

•
•

•

1

Power connection

2

Power cord and adapter

If you are using a power strip, make sure the power strip is on. Or, try plugging
the product directly into a power outlet.
Test the power outlet to make sure it is working. Plug in an appliance that you
know works, and see if the appliance has power. If not, then there might be a
problem with the power outlet.
If you plugged the product into a switched outlet, make sure the outlet is switched
on. If it is switched to on but still does not work, then there might be a problem
with the power outlet.

Cause: The product was not properly connected to a power supply.
If this did not solve the issue, try the next solution.

Setup troubleshooting
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Solution 1: Make sure the power cord is connected
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Solution 2: Press the On button more slowly
Solution: The product might not respond if you press the On button too quickly.
Press the On button once. It might take a few minutes for the product to turn on. If
you press the On button again during this time, you might turn the product off.
CAUTION: If the product still does not turn on, it might have a mechanical failure.
Unplug the product from the power outlet.
Contact HP support for service.
Go to: www.hp.com/support. If prompted, choose your country/region, and then
click Contact HP for information on calling for technical support.
Cause:

You pressed the On button too quickly.

After setting up the product, it does not print
Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
Solve a problem

•
•
•

Solution 1: Press the On button to turn on the product
Solution 2: Set your product as the default printer
Solution 3: Check the connection between the product and computer

Solution 1: Press the On button to turn on the product
Solution: Look at the On button located on the product. If it is not lit, the product is
turned off. Make sure the power cord is firmly connected to the product and plugged
into a power outlet. Press the On button to turn on the product.
Cause:

The product might not have been turned on.

If this did not solve the issue, try the next solution.

Solution 2: Set your product as the default printer
Solution: Use the system tools on your computer to change your product to be the
default printer.
Cause: You sent the print job to the default printer, but this product was not the
default printer.
If this did not solve the issue, try the next solution.

Solution 3: Check the connection between the product and computer
Solution:
Cause:
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Check the connection between the product and computer.

The product and computer were not communicating with each other.

The registration screen does not appear
Solution: You can access the registration (Sign up now) screen from the Windows
taskbar by clicking Start, pointing to Programs or All Programs, HP, Deskjet F4500
All-in-One series, and then clicking Product Registration.
Cause: The registration screen did not launch automatically.

Uninstall and reinstall the software
If your installation is incomplete, or if you connected the USB cable to the computer before
prompted by the software installation screen, you might need to uninstall and then
reinstall the software. Do not simply delete the HP All-in-One application files from your
computer. Make sure to remove them properly using the uninstall utility provided when
you installed the software that came with the HP All-in-One.

Solve a problem

To uninstall and reinstall the software
1. On the Windows taskbar, click Start, Settings, Control Panel (or just Control
Panel).
2. Double-click Add/Remove Programs (or click Uninstall a program).
3. Select HP Photosmart All-In-One Driver Software, and then click Change/
Remove.
Follow the onscreen instructions.
4. Disconnect the product from your computer.
5. Restart your computer.
NOTE: It is important that you disconnect the product before restarting your
computer. Do not connect the product to your computer until after you have
reinstalled the software.
6. Insert the product CD-ROM into your computer’s CD-ROM drive and then start the
Setup program.
NOTE: If the Setup program does not appear, locate the setup.exe file on the
CD-ROM drive and double-click it.
NOTE: If you no longer have the installation CD, you can download the software
from www.hp.com/support.
7. Follow the onscreen instructions and the instructions provided in the printed
documentation that came with the product.
When the software installation is complete, the HP Digital Imaging Monitor icon appears
in the Windows system tray.

Setup troubleshooting
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Print troubleshooting
Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
•
•
•
•
•

Check cartridges
Check paper
Check product
Check printer settings
Reset the product

Check cartridges
Try the following solutions.
•
•

Solution 1: Make sure you are using genuine HP ink cartridges
Solution 2: Check the ink levels

Solution 1: Make sure you are using genuine HP ink cartridges
Solution:

Check to see if your ink cartridges are genuine HP ink cartridges.

HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.
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NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product
service or repairs required as a result of using a non-HP supply will not be covered
under warranty.
If you believe you purchased genuine HP ink cartridges, go to:
www.hp.com/go/anticounterfeit
Cause: Non-HP ink cartridges were being used.
If this did not solve the issue, try the next solution.

Solution 2: Check the ink levels
Solution:

Check the estimated ink levels in the cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the cartridges until print quality becomes unacceptable.
Solve a problem

For more information, see:
“Check the estimated ink levels” on page 37
Cause: The ink cartridges might have insufficient ink.
If this did not solve the issue, try the next solution.

Check paper
Try the following solutions.
•
•

Solution 1: Make sure only one type of paper is loaded
Solution 2: Load the stack of paper correctly

Solution 1: Make sure only one type of paper is loaded
Solution:

Load only one type of paper at a time.

Cause: More than one type of paper was loaded in the paper tray.
If this did not solve the issue, try the next solution.

Solution 2: Load the stack of paper correctly
Solution: Remove the stack of paper from the paper tray, reload the paper, and
then slide the paper-width guide inward until it stops at the edge of the paper.
For more information, see:
“Load media” on page 27
Cause: The paper guides were not positioned correctly.

Print troubleshooting
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Check product
Try the following solutions.
•
•

Solution 1: Align the print cartridges
Solution 2: Automatically clean the print cartridges.

Solution 1: Align the print cartridges
Solution:

Aligning the print cartridges can help ensure high-quality output.

To align the print cartridges from the HP Photosmart Software
1. Load letter or A4 unused plain white paper into the paper tray.
2. In the HP Solution Center, click Settings.
3. In the Print Settings area, click Printer Toolbox.
NOTE: You can also open the Printer Toolbox from the Print Properties
dialog box. In the Print Properties dialog box, click the Features tab, and
then click Printer Services.
Solve a problem

The Printer Toolbox appears.
4. Click the Device Services tab.
5. Click Align the Print Cartridges.
6. When prompted, ensure plain white letter or A4 paper is loaded in the paper tray
and follow the onscreen instructions.
NOTE: If you have colored paper loaded in the paper tray when you align
the print cartridges, the alignment will fail. Load unused plain white paper into
the paper tray, and then try the alignment again.
The product prints a print cartridge alignment sheet.
7. Load the page print side down on the right front corner of the glass, and then
press Start Copy Black or Start Copy Color to scan the page.
When the On button stops flashing, the alignment is complete and the page can
be removed. Recycle or discard the page.
Cause:

The printer needed to be aligned.

If this did not solve the issue, try the next solution.

Solution 2: Automatically clean the print cartridges.
Solution:

Clean the print cartridges.

For more information, see “Automatically clean print cartridges” on page 38
Cause:

The print cartridge nozzles needed to be cleaned.

If this did not solve the issue, try the next solution.

Check printer settings
Try the following solutions.
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•
•
•

Solution 1: Check the print settings
Solution 2: Verify the paper size setting
Solution 3: Check the printer margins

Solution 1: Check the print settings

NOTE: On some computer screens, colors might appear differently than they do
when printed on paper. In this case, there is nothing wrong with the product, print
settings, or ink cartridges. No further troubleshooting is required.
Cause: The print settings were set incorrectly.
If this did not solve the issue, try the next solution.

Solution 2: Verify the paper size setting
Solution: Verify that you have selected the proper paper size setting for your
project. Make sure that you have loaded the correct paper size in the paper tray.
Cause: The paper size setting might not have been set correctly for the project you
were printing.
If this did not solve the issue, try the next solution.

Solution 3: Check the printer margins
Solution:

Check the printer margins.

Print troubleshooting
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Solution: Check the print settings.
• Check the print settings to see if the color settings are incorrect.
For example, check to see if the document is set to print in grayscale. Or, check
to see if advanced color settings such as saturation, brightness, or color tone, are
set to modify the appearance of colors.
• Check the print quality setting and make sure it matches the type of paper loaded
in the product.
You might need to choose a lower print quality setting, if colors are running into
each other. Or, choose a higher setting if you are printing a high-quality photo,
and then make sure photo paper such as HP Advanced Photo Paper, is loaded
in the paper tray.

Chapter 9

Make sure the margin settings for the document do not exceed the printable area of
the product.
To check your margin settings
1. Preview your print job before sending it to the product.
In most software applications, click the File menu, and then click Print Preview.
2. Check the margins.
The product uses the margins you have set in your software application, as long
as they are greater than the minimum margins the product supports. For more
information about setting margins in your software application, see the
documentation that came with the software.
3. Cancel the print job if the margins are not satisfactory, and then adjust the margins
in your software application.
Cause:

The margins were not set correctly in your software application.

If this did not solve the issue, try the next solution.

Solve a problem

Reset the product
Solution: Turn off the product, and then unplug the power cord. Plug the power
cord back in, and then press the On button to turn on the product.
Cause:

The product experienced an error.

If this did not solve the issue, try the next solution.

Scan troubleshooting
Use this section to solve these scan problems:
•
•
•
•

Scanned image is incorrectly cropped
Scanned image shows dotted lines instead of text
Text format is incorrect
Text is incorrect or missing

Scanned image is incorrectly cropped
Solution: The autocropping feature in the HP Solution Center software crops
anything that is not part of the main image. Sometimes this might not be what you
want. In that case, turn off autocropping in the HP Solution Center software and crop
the scanned image manually, or not at all.
Cause:

The software was set to automatically crop scanned pictures.

Scanned image shows dotted lines instead of text
Solution:
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Make a black-and-white copy of the original and then scan the copy.

Cause: If you used the Text image type to scan text that you planned to edit, the
scanner might not have recognized color text. The Text image type scans at 300 x 300
dpi, in black and white.
If you scanned an original that has graphics or artwork surrounding the text, the
scanner might not have recognized the text.

Text format is incorrect
Solution: Some applications cannot handle framed text formatting. Framed text is
one of the scan document settings in the software. It maintains complex layouts, such
as multiple columns from a newsletter, by putting the text in different frames (boxes)
in the destination application. In the software, select the correct format so that the
scanned text layout and formatting are retained.
Cause: The scan document settings were incorrect.

Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
•
•

Solution 1: Adjust the brightness in the software
Solution 2: Clean the glass and lid

Solution 1: Adjust the brightness in the software
Solution:

Adjust the brightness in the software, and then rescan the original.

Cause: The brightness was not set correctly.
If this did not solve the issue, try the next solution.

Solution 2: Clean the glass and lid
Solution: Turn off the product, unplug the power cord, and use a soft cloth to wipe
the glass and the back of the document lid.
Cause: Debris might have been stuck on the glass or on the back of the document
lid. This can cause poor-quality scans.

Copy troubleshooting
Use this section to solve these copy problems:
•
•

Parts of the original do not appear or are cut off
The printout is blank

Copy troubleshooting
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Text is incorrect or missing

Chapter 9

Parts of the original do not appear or are cut off
Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
•
•

Solution 1: Place the original correctly on the glass
Solution 2: Clean the scanner glass

Solution 1: Place the original correctly on the glass
Solution:

Load your original print side down on the right front corner of the glass.

Solve a problem

Cause:

The original was placed incorrectly on the glass.

If this did not solve the issue, try the next solution.

Solution 2: Clean the scanner glass
Solution: Clean the scanner glass and make sure that there are no foreign
materials adhering to it.
Cause: The scanner glass was dirty, causing the product to include an area in the
copy that was larger than the document.

The printout is blank
Try the following solutions to resolve the issue. Solutions are listed in order, with the most
likely solution first. If the first solution does not solve the problem, continue trying the
remaining solutions until the issue is resolved.
•
•

Solution 1: Place the original correctly on the glass
Solution 2: Check the ink levels in the print cartridges

Solution 1: Place the original correctly on the glass
Solution:
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Load your original print side down on the right front corner of the glass.

Cause: The original was placed incorrectly on the glass.

Solution 2: Check the ink levels in the print cartridges
Solution:

Check the estimated ink levels remaining in the print cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having a
replacement cartridge available to avoid possible printing delays. You do not need
to replace the print cartridges until print quality becomes unacceptable.
If there is ink remaining in the print cartridges, but you are still noticing a problem,
print a self-test report to determine if there is a problem with the print cartridges. If the
self-test report shows a problem, clean the print cartridges. If the problem persists,
you might need to replace the print cartridges.
Cause: The print cartridges needed to be cleaned or there was insufficient ink.

Errors
This section contains the following categories of messages about your product:
•
•
•

Flashing lights
Wireless indicator light
Printing in ink-backup mode

Flashing lights
The lights on the product flash in special sequences to inform you about various status
or error conditions. Refer to the following table for information on solving your error
condition based on which lights are on or flashing on the product.

Errors
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If this did not solve the issue, try the next solution.
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On light

Attention
light

Ink level
indicator
light

Description

Solution

Off

Off

Off

The product is turned off.

Press the On button to
turn the product on.

On

Fast
blinking

Both fast
blinking

The tape was not
removed from one or
both print cartridges.

Remove the print
cartridge, remove tape,
and reinsert the print
cartridge.

On

Fast
blinking

Current ink
levels

The product is out of
paper.

Load paper and press any
button to resume.

The product has a paper
jam.

Remove paper jam and
press any button to
resume.

Fast
blinking

Current ink
levels

The front access door or
the print cartridge access
door is open.

Close the front access
door or the print cartridge
access door.

On

Fast
blinking

Both fast
blinking

The print cartridges are
missing or not seated
correctly.

Install or remove and
reinsert print cartridges.

Solve a problem

On

The print cartridge might
be defective.
The tape was not
removed from one or
both print cartridges.
The print cartridge is not
intended for use in this
product.

On

Fast
Blinking

Current ink
levels

The print carriage is
stalled.

Remove the print
cartridge, remove tape,
and reinsert the print
cartridge.
The print cartridge might
not be supported for use in
the product. For more
information about
compatible print
cartridges, see “Order ink
supplies” on page 37.
Open the front access
door, and clear the
carriage jam.
Press any button except
the On button.
Pressing the On button
will turn off the product.

On

Off

Tri-color
print
cartridge
light On
Black print
cartridge
light Off

On
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Off

Tri-color
print

The tri-color print
cartridge is getting low
on ink.
The tri-color print
cartridge has been
removed.

The black print cartridge
is getting low on ink.

Replace the tri-color print
cartridge when print
quality is no longer
acceptable.
Replace the tri-color print
cartridge, or print in inkbackup mode with the
black print cartridge. For
more information, see
“Printing in ink-backup
mode” on page 58.
Replace the black print
cartridge when print

(continued)
Attention
light

Ink level
indicator
light

Description

Solution

cartridge
light Off

The black print cartridge
has been removed.

quality is no longer
acceptable.

Black print
cartridge
light On

Replace the black print
cartridge, or print in inkbackup mode with the
tricolor print cartridge. For
more information, see
“Printing in ink-backup
mode” on page 58.

Blinking

Off

Current ink
levels

Product is processing
print, scan, copy or
maintenance job such as
alignment.

Wait for product to
complete job.

Fast
Blinking

Fast
Blinking

Both fast
blinking

The product has a fatal
error.

1.
2.
3.

4.

Turn off the product.
Unplug the power
cord.
Wait a minute, then
plug the power cord
back in.
Turn on the product.

If the problem persists,
contact HP Support.

Wireless indicator light
The wireless indicator on the product flashes in special sequences to inform you about
various status or error conditions. Refer to the following table for information on solving
your error condition based on the wireless indicator flashing on the product.

Table 9-1 Wireless indicator light
Wireless button
light

Description

Solution

The product is
connected to a
wireless network.

The product can now print
wirelessly.

Wi r e l e s s

On

Wireless Protected
Setup (WPS)
successful.

Errors
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Wireless indicator light (continued)
Wireless button
light

Description

Solution

The product cannot
connect to a wireless
network.

1.

No wireless signal
available but wireless
radio on the product is
turned on.

2.

The product is
searching for
available wireless
networks.

Wait for product to connect
to an access point.

Wi r e l e s s

Blinking

Blinking

Check if the wireless
router or access point
is turned on.
Move the product
closer to the wireless
router or access point.

Wireless Protected
Setup (WPS) in
progress.
Solve a problem

Fast blinking

Wireless Protected
Setup (WPS)
progress error.

Press any key to clear the
error or wait for one minute.

Printing in ink-backup mode
Solution: If you receive the ink-backup mode message and two print cartridges are
installed in the product, verify that the protective piece of plastic tape has been
removed from each print cartridge. When plastic tape covers the print cartridge
contacts, the product cannot detect that the print cartridge is installed.

1

Copper-colored contacts

2

Plastic tape with pink pull tab (must be removed before installing)

3

Ink nozzles under tape

Cause: When the product detected that only one print cartridge is installed, inkbackup mode is initiated. This printing mode lets you print with a single print cartridge,
but it slows the product and affects the quality of printouts.
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10 Stop the current job

Stop the current job

To stop a print job from the HP All-in-One
▲ Press Cancel on the control panel. If the print job does not stop, press Cancel again.
It can take a few moments for printing to be cancelled.

Stop the current job

59

Chapter 10

Stop the current job
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11 Technical information
The technical specifications and international regulatory information for the HP All-in-One are
provided in this section.
For additional specifications, see the printed documentation that came with the HP All-in-One.
This section contains the following topics:
•
•
•
•
•

Notice
Specifications
Environmental product stewardship program
Regulatory notices
Regulatory wireless statements

Notice
Hewlett-Packard Company notices
The information contained in this document is subject to change without notice.
All rights reserved. Reproduction, adaptation, or translation of this material is prohibited without prior written permission
of Hewlett-Packard, except as allowed under copyright laws. The only warranties for HP products and services are set forth
in the express warranty statements accompanying such products and services. Nothing herein should be construed as
constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.
© 2009 Hewlett-Packard Development Company, L.P.
Windows, Windows 2000, and Windows XP are U.S. registered trademarks of Microsoft Corporation.
Windows Vista is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other
countries.
Intel and Pentium are trademarks or registered trademarks of Intel Corporation or its subsidiaries in the United States and
other countries.

Specifications
Technical specifications for the HP All-in-One are provided in this section. For complete product
specifications, see the Product Data Sheet at www.hp.com/support.
System requirements
Software and system requirements are located in the Readme file.
For information about future operating system releases and support, visit the HP online support Web
site at www.hp.com/support.

•

Allowable operating temperature range: 5 ºC to 40 ºC (41 ºF to 104 ºF)

•
•

Humidity: 15% to 80% RH non-condensing; 28 ºC maximum dewpoint
Non-operating (Storage) temperature range: –40 ºC to 60 ºC (–40 ºF to 140 ºF)

•

In the presence of high electromagnetic fields, it is possible the output from the HP All-in-One
may be slightly distorted

•

HP recommends using a USB cable less than or equal to 3 m (10 feet) in length to minimize
injected noise due to potential high electromagnetic fields

Paper tray capacity
Plain paper sheets (75 g/m² [20 lb]): Up to 80
Envelopes: Up to 10
Index cards: Up to 30
Photo paper sheets: Up to 30
Technical information
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Environmental specifications
•
Recommended operating temperature range: 15 ºC to 32 ºC (59 ºF to 90 ºF)

Chapter 11
Paper size
For a complete list of supported media sizes, see the printer software.
Paper weights
Plain Paper: 75 to 90 g/m² (20 to 24 lb)
Envelopes: 75 to 90 g/m² (20 to 24 lb)
Cards: Up to 200 g/m² (110-lb index maximum)
Photo Paper: Up to 280 g/m² (75 lb)
Print specifications
•
Print speeds vary according to the complexity of the document
•

Panorama-size printing

•

Method: drop-on-demand thermal inkjet

•

Language: PCL3 GUI

Copy specifications
•
Digital image processing
•
•

Maximum number of copies varies by model
Copy speeds vary according to the complexity of the document and model

•

Maximum copy enlargement ranging from 200-400% (depends on model)

•

Maximum copy reduction ranging from 25-50% (depends on model)

Scan specifications
•
Image editor included
•

Twain-compliant software interface

•

Resolution: up to 4800 x 4800 ppi optical (depends on model); 19200 ppi enhanced (software)
For more information about ppi resolution, see the scanner software.

•

Color: 48-bit color, 8-bit grayscale (256 levels of gray)

•

Maximum scan size from glass: 21.6 x 29.7 cm (8.5 x 11.7 inches)

Print resolution
To find out about the printer resolution, see the printer software. For more information, see “View
the print resolution” on page 23.
Cartridge yield
Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.
Acoustic information
If you have Internet access, you can get acoustic information from the HP Web site. Go to:
www.hp.com/support.

Environmental product stewardship program

Technical information

Hewlett-Packard is committed to providing quality products in an environmentally sound manner.
Design for recycling has been incorporated into this product. The number of materials has been kept
to a minimum while ensuring proper functionality and reliability. Dissimilar materials have been
designed to separate easily. Fasteners and other connections are easy to locate, access, and
remove using common tools. High priority parts have been designed to access quickly for efficient
disassembly and repair.
For more information, visit HP’s Commitment to the Environment Web site at:
www.hp.com/hpinfo/globalcitizenship/environment/index.html
This section contains the following topics:
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•

Eco-Tips

•

Paper use

•

Plastics

•

Material safety data sheets

•

Recycling program

•

HP inkjet supplies recycling program

•

Power consumption

•

Disposal of waste equipment by users in private households in the European Union

•

Chemical Substances

Eco-Tips
HP is committed to helping customers reduce their environmental footprint. HP has provided the
Eco-Tips below to help you focus on ways to assess and reduce the impact of your printing choices.
In addition to specific features in this product, please visit the HP Eco Solutions web site for more
information on HP’s environmental initiatives.
www.hp.com/hpinfo/globalcitizenship/environment/
Your product's Eco features
•
Smart Web printing: The HP Smart Web Printing interface includes a Clip Book and Edit
Clips window where you can store, organize, or print clips you have gathered from the Web.
For more information, see “Print a Web page” on page 21.
•

Energy Savings information: To determine the ENERGY STAR® qualification status for this
product, see “Power consumption” on page 64.

•

Recycled Materials: For more information regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability
to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions,
and partners with some of the largest electronic recycling centers throughout the world. HP
conserves resources by reselling some of its most popular products. For more information regarding
recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Environmental product stewardship program
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HP inkjet supplies recycling program
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Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified
to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for imaging
equipment. The following mark will appear on ENERGY STAR qualified imaging products:

Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/
go/energystar

Technical information
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Dansk

Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.

Nederlands

Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product
hebt aangeschaft.

Eesti

Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult.
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme
ostsite.

Suomi

Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös,
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen
jälleenmyyjältä.

Ελληνικά

Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.

Magyar

A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata,
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik.
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.

Latviski

Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces,
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.

Lietuviškai

Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.

Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade,
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.
Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili,
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini,
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.
Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar
kasserade produkter för återvinning.
Изхвърляне на оборудване за отпадъци от потребители в частни домакинства в Европейския съюз
Този символ върху продукта или опаковката му показва, чепродуктът не трябва да се изхвърля заедно с домакинските отпадъци. Вие имате отговорността да изхвърлите
оборудването за отпадъци, като го предадете на определен пункт за рециклиране на електрическо или механично оборудване за отпадъци. Отделното събиране и рециклиране
на оборудването за отпадъци при изхвърлянето му помага за запазването на природни ресурси и гарантира рециклиране, извършено така, чеда не застрашава човешкото
здраве и околната среда. За повече информация къде можете да оставите оборудването за отпадъци за рециклиране се свържете със съответния офис в града ви, фирмата за
събиране на отпадъци или смагазина, от който сте закупили продукта

Română

Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que
adquiriu o produto.

Înlăturarea echipamentelor uzate de către utilizatorii casnici din Uniunea Europeană
Acest simbol de pe produs sau de pe ambalajul produsului indică faptul că acest produs nu trebuie aruncat alături de celelalte deşeuri casnice. În loc să procedaţi astfel, aveţi
responsabilitatea să vă debarasaţi de echipamentul uzat predându-l la un centru de colectare desemnat pentru reciclarea deşeurilor electrice şi aechipamentelor electronice.
Colectarea şi reciclarea separată aechipamentului uzat atunci când doriţi să îl aruncaţi ajută la conservarea resurselor naturale şi asigură reciclarea echipamentului într-o manieră care
protejează sănătatea umană şi mediul. Pentru informaţii suplimentare despre locul în care se poate preda echipamentul uzat pentru reciclare, luaţi legătura cu primăria locală, cu
serviciul de salubritate sau cu vânzătorul de la care aţi achiziţionat produsul.

Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
Environmental product stewardship program
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English
Français
Deutsch
Italiano
Español
Česky

Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt
zakoupili.

Português

Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la
tienda donde adquirió el producto.

Slovenčina

Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza,
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.

Slovenščina

Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.

Svenska

Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants.
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.

Български

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.

Polski

Disposal of waste equipment by users in private households in the European Union
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1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach.

Regulatory notices
The HP All-in-One meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:
•

Regulatory model identification number

•

FCC statement

•

Notice to users in Korea

•

VCCI (Class B) compliance statement for users in Japan

•

Notice to users in Japan about the power cord

•

HP Deskjet F4500 All-in-One series declaration of conformity

Regulatory model identification number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRH-0801-01. This regulatory number should not
be confused with the marketing name (HP Deskjet F4500 All-in-One series, etc.) or product numbers
(CB755-64001, etc.).

Technical information
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FCC statement

FCC statement
The United States Federal Communications Commission (in 47 CFR 15.105) has specified
that the following notice be brought to the attention of users of this product.
This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:
•
•
•
•

Reorient the receiving antenna.
Increase the separation between the equipment and the receiver.
Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

For further information, contact:
Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501
Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this
device that are not expressly approved by HP may void the user's authority to operate the
equipment.
This device complies with Part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired
operation.

Notice to users in Korea
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VCCI (Class B) compliance statement for users in Japan
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Notice to users in Japan about the power cord

HP Deskjet F4500 All-in-One series declaration of conformity

DECLARATION OF CONFORMITY
according to ISO/IEC 17050-1 and EN 17050-1

Supplier's Name:
Supplier's Address:

DoC #: SNPRH-0801-01 Rev A
Hewlett-Packard Company
20, Jia Feng Road Waigaoqiao Free Trade Zone Pudong, Shanghaiˈ PRC
200131

declares, that the product
Product Name and Model:
HP Deskjet F4500 series
Regulatory Model Number: 1)
SNPRH-0801-01
Product Options:
All
Radio Module:
RSVLD-0707
Conforms to the following Product Specifications and Regulations:
EMC:
CISPR 22: 2005 / EN 55022: 2006 Class B
EN 55024:1998 + A1:2001 + A2:2003
EN 61000-3-2: 2006
EN61000-3-3:1995+A1:2001+A2:2005
FCC CFR 47 Part 15 Class B / ICES-003,Issue 4 Class B
Safety:
EN 60950-1:2001+A11: 2004 / IEC 60950-1:2001
EN 60825-1 1994+A1:2002+A2:2001
Environment˖
˖
WEEE Directive 2002/96/EC
RoHS Directive 2002/95/EC.
Radio:
EN 300 328 V1.7.1
EN 301 489-1 V1.6.1/ EN 301 489-17 V1.2.1
Health˖
EU: 1999/519/EC
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device
may not cause harmful interference, and (2) this device must accept any interference received, including interference
that may cause undesired operation.
The product herewith complies with the requirements of the Low Voltage Directive 2006/95/EC, EMC Directive
2004/108/EC and the R&TTE Directive 99/5/EC, WEEE Directive 2002/96/EC and RoHS Directive 2002/95/EC
and carries the CE-marking accordingly.
Additional Information:
1) This product is assigned a Regulatory Model Number which stays with the regulatory aspects of the design. The
Regulatory Model Number is the main product identifier in the regulatory documentation and test reports, this
number should not be confused with the marketing name or the product numbers.

2 Aug 2009

Peng Cong
IPMO (China) Product Regulations Manager

Local contact for regulatory topics only:

Technical information

EMEA: Hewlett-Packard GmbH, HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, Germany www.hp.com/go/certificates
U.S.: Hewlett –Packard, 3000 Hanover St., Palo Alto 94304, U.S.A. 650-857-1501
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Regulatory wireless statements
This section contains the following regulatory information pertaining to wireless products:
•

Exposure to radio frequency radiation

•

Notice to users in Brazil

•

Notice to users in Canada

•

European Union regulatory notice

•

Notice to users in Taiwan

Exposure to radio frequency radiation

Exposure to radio frequency radiation
Caution The radiated output power of this device is far below the FCC radio
frequency exposure limits. Nevertheless, the device shall be used in such a manner
that the potential for human contact during normal operation is minimized. This
product and any attached external antenna, if supported, shall be placed in such
a manner to minimize the potential for human contact during normal operation. In
order to avoid the possibility of exceeding the FCC radio frequency exposure
limits, human proximity to the antenna shall not be less than 20 cm (8 inches)
during normal operation.

Notice to users in Brazil

Aviso aos usuários no Brasil
Este equipamento opera em caráter secundário, isto é, não tem direito à proteção
contra interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar
interferência a sistemas operando em caráter primário. (Res.ANATEL 282/2001).

Notice to users in Canada

Notice to users in Canada/Note à l'attention des utilisateurs canadiens
For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise
emissions from the digital apparatus set out in the Radio Interference Regulations of the
Canadian Department of Communications. The internal wireless radio complies with RSS
210 and RSS GEN of Industry Canada.

Regulatory wireless statements

Technical information

Utiliser à l'intérieur. Le présent appareil numérique n'émet pas de bruit radioélectrique
dépassant les limites applicables aux appareils numériques de la classe B prescrites dans
le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications
du Canada. Le composant RF interne est conforme a la norme RSS-210 and RSS GEN
d'Industrie Canada.
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European Union regulatory notice

European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:
•
•

Low Voltage Directive 2006/95/EC
EMC Directive 2004/108/EC

CE compliance of this product is valid only if powered with the correct CE-marked AC
adapter provided by HP.
If this product has telecommunications functionality, it also complies with the essential
requirements of the following EU Directive:
•

R&TTE Directive 1999/5/EC

Compliance with these directives implies conformity to harmonized European standards
(European Norms) that are listed in the EU Declaration of Conformity issued by HP for
this product or product family. This compliance is indicated by the following conformity
marking placed on the product.

The wireless telecommunications functionality of this product may be used in the
following EU and EFTA countries:
Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland,
France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein,
Lithuania, Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania,
Slovak Republic, Slovenia, Spain, Sweden, Switzerland and United Kingdom.

Products with 2.4-GHz wireless LAN devices
France
For 2.4 GHz Wireless LAN operation of this product certain restrictions apply: This
product may be used indoor for the entire 2400-2483.5 MHz frequency band (channels
1-13). For outdoor use, only 2400-2454 MHz frequency band (channels 1-9) may be
used. For the latest requirements, see http://www.arcep.fr
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Notice to users in Taiwan

Regulatory wireless statements
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